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Introduction

A growing number of educators agree that one of the best ways to help children learn to
read is to let them express themselves in writing. PlayWrite was developed with this
approach in mind. In PlayWrite, children create puppet characters, write scripts for them,
and then listen to the characters talk. But PlayWrite goes beyond other reading-through-
writing projects in several important ways.

First of all, PlayWrite creates an environment in which children care about the things they
read and write. Young children learn spoken language rather easily because they want to
communicate with other people in the world. Similarly, with PlayWrite, children write
because they wantto make the puppets perform. In this way, PlayWrite fits into the spirit of
the whole language approach to reading and writing—it provides children with a
meaningful and motivating medium for expressing their ideas and feelings. With
PlayWrite, reading and writing are part of a natural, and enjoyable activity.

While using PlayWrite, children continually experiment with letters and words. They sound
out words, type them in, and listen to how the puppets say them. If they don't like the way
certain words sound, they change the spellings and try again. In this way, children gain a
firm foundation in practical phonics—that is, an understanding of how letters (and
combinations of letters) translate into sounds. Consequently, PlayWrite helps children
make the transition from the familiar world of spoken language to an exciting new world of
written language.

“We believe that children do most of their learning while they are playing, building, and
exploring. That's what PlayWriteis all about: Children learn about language by building
and playing with words.”

Mitchel Resnick and Steve Ocko



Overview

f File Setup Uords \

\ Say-A1ll Say Erase-All Effects j

ACTIVITIES: choosing costumes, expressions, and scenery for the scripts
 writing scripts for the puppets
* editing scripts written for the puppets

« listening and watching the puppets perform scripts

SKILLS:

to provide students with a motivating medium for
developing characters and dialogue

* to 'provide students with the opportunity and enjoyment of
listening to their own writing

* to provide students with an understanding of phonics and
phonetic spelling of words

 to provide an environment for students to use combined
skills of reading, writing, and listening

- Grade Level: 1-6



Quick Start

for Teachers

Begin 1. Insert the 3.5 PlayWrite disk into the Apple IIGS 3.5 disk drive.
Playwrite

2. Turn on the computer and monitor.

3. The screen below appears with the puppets Bravo and Encore.

(T File Setup Words P
Change 1. Click on these areas to change puppets' costumes, expressions,
Costumes, and scenery:
Expressions,
and Scenery * puppets' hats and clothes (tops and bottoms—many possible

combinations)
* puppets' mouths (happy/sad)
 stage floor (three choices)

* background (seven choices)



Quick Start for Teachers

Write a 1. Notice that Bravo’s name is listed as a puppet in the script.
_— New Script (Encore is the name of the other puppet.) For now, do not
“ change the puppets’ names. To later change a puppet'’s
name, voice speed and pitch, see Setup (page 13).

2. Type in these lines for Bravo:
“We're top-notch actors you'll agree
Our lines we’'ll say so perfectly.”

3. Click on Say (or press the Enter Key) to listen to Bravo speak.
Bravo’s lines are pronounced correctly, but sometimes words
have to be spelled phonetically for correct pronunciation.

To later change pronunciation of words, see Words (page 14 ).

4. Click on the large =p between the puppets (or press Tab Key) to
change performers. (Encore's name is automatically inserted into
the script and the cursor is placed after the name.)

5. Type in these lines for Encore:
“Comedy, tragedy, poems, and more,
Just write our lines, and we’'ll perform.”
(If you make a mistake when typing, press the Delete Key
to move backwards erasing one letter at a time.)

(P\
6. Click on Say-All to hear the entire script.
7. Move line by line through
the script by clicking on the
Scroll Bar (at the right side
of the script area). You can Scroll Bar
also use the Arrow Keys to
move through the script.
8. Move quickly all the way to the beginning or end of the script,
by holding down the G Key and pressing the 4 or | Keys.
For more editing details, see Editing Features (page 10).
CA



Quick Start for Teachers
9. Add a special effect(s) to the script:
 place the cursor at the end of the script

» click on Effects to see the Effects Menu

Open

Close
Hoise
Claps
Laugh
Drums

Happy
Sad

Cancel

 click on Claps. (It will be demonstrated and automatically
inserted into the script.)

10. Erase-All erases the text currently being written. (Do not erase
this time.)

11. Place the cursor at the end of your script and then click on
Effects and then on Close. Close will be inserted into the script
and the curtain will close.



Listento
a Prepared
Script

Quick Start for Teachers

12. Save your script (and the puppets and scenery) by clicking on
File. Then click on Save. Type in a name that is related to the
script. Then click on Save. |

Setup

S:PlayWrite:Scripts:

35 free of 800 k. ( Disk
ZBogtor
Gibreevings
Rl 4

Starver.2 { Goen
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Script to save: €
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|
\
|

3 "% II I { Cancel

L

Erase-All

Say-All Say Effects

\=

13. Print your script by clicking on File, then on Print. (The script and
stage can be printed together or separately.)

14. Write a new script by clicking on File to see the File Menu and
then on New.

15. Quit PlayWrite by clicking on File, then on Quit.

1. Click on File. The File Menu appears. Click on Open to see a list
of PlayWrite scripts.

) T
Effects

Say-Al1l Say Erase-All




Quick Start for Teachers

2. Click on the script "Greetings" (it will be highlighted) and then
click on Open (or press Return) to load it.

]

OStarter.1
OStarter.2
OStarter.3

Disk

[ Open

( Close

Cancel

Say-Al1l

Say

Erase-All

Effects

close at the end of the script.)

\C —/

3. Click on Say (or press the Enter Key) to listen to Bravo speak.
(Notice that the large 4= between the puppets points to Bravo
and the cursor is placed at the dialogue line.)

4. Now click on Say again (or press the Enter Key) to listen to
Encore speak. (Notice that the Arrow between the puppets is now
pointing to Encore and the cursor is placed at the dialogue line.)

5. Press the Esc Key to stop the puppets while they are speaking.
(Click on Say and the current line will be repeated.)

6. Click on Say-All to listen to the entire script. (The curtain will



Program Description

Load PlayWrite by inserting the 3.5 PlayWrite disk into the Apple IIGS 3.5 disk drive.
Turn on the computer and monitor. The program is ready to use when you see the
screen below:

To see To change
scripts a puppet's
and work name, gender,
with them speed, and
page 12 pitch of voice
l page 13
\
Top Menu —»- Setup Words |
To indicate who

is speaking

Scroll Bar:
To move uy|
Script ——» ~*and down P
Sau-A11 S E A1l Effect bough the
ay- a rase- ects i
Bottom Menu-s= \ Y Y as Y, script
1 To hear T ?
To hear the puppet To erase To aqd
an entire perform a text of script special
script line of script being effects
page 11 page 11 written page 11

Features are explained In detall on the pages noted.
Notice that the screen is divided into four sections:
4 Stage: lets you choose the costumes and scenery.
4 Script: lets you write and read your script.
¢ Bottom Menu: lets you listen to and edit your script.
4 Top Menu: lets you open a script, choose a puppet's name, gender, and

voice, and add or change words phonetically for correct pronunciation in
a script.

8



Program Description
¢ Stage

(’“ Changing puppet costumes, expressions, and scenery

The puppets and stage have many “hotspots” that can be changed. Just move the
mouse to the region you want to change, click, and watch what happens.

| File Setup Words |

Say-Al1l Say Erase-All Effects

\. ,

» To change a puppet's costume and expression:

— click on the puppet'’s hat and clothes (tops and bottoms—many costume
combinations)

— click on the mouth (happy/sad)
» To change the stage setting:
— click on the stage floor (three choices)

— click on the background behind the puppets (seven choices)



Program Description

4 Script
« To change puppets' names, see Setup (page 13). |
» To write lines for a script, begin typing at the cursor (after ¢ Opene ).
» To add (or delete) sound effects and dther stage effects, see Effects (page 11).
Editing Features

— Enter Key: Pressing the Enter Key is the same as clicking on Say; the current
puppet will perform one entry in the script.

— Escape Key: If you want to stop the puppets while they are performing, press
the Escape Key.

— Tab Key: Pressing the Tab Key has the same effect as clicking the large arrow
between the puppets; it will change the direction of the arrow and allow the
other puppet to speak.

— Arrow Keys: By pressing the Arrow Keys on the keyboard, you can move the
cursor up, down, left, or right.

— Delete Key: Use the Delete Key to erase backwards one letter at a time or to
delete an Effect in the script.

— Scroll Bar: The Scroll Bar is the area on the screen to the right of the script.
By clicking on different parts of the Scroll Bar, you can move up and down
through the script. If you click on the arrows at the top and bottom of the Scroll
Bar, the cursor will move up or down one line. If you click on the rectangles at
the middle of the Scroll Bar, the cursor will move up or down by one “page” in
the script. If you hold down the @ Key when you click on the Scroll Bar, the
cursor will move all the way to the beginning or the end of the script.

— G-Arrow Keys: To move through the script quickly, hold down the G Key
while pressing the Arrow Key. For example, if you hold down the G Key while
you press the « Key, the cursor will move all the way to the beginning of a line
of dialogue. Hold down the @ Key and press the — Key and the cursor will
move all the way to the end of the line. If you hold down the G Key while
you press the ¢ or | Key, the cursor will move all the way to the beginning or
end of the script.

10



Program Description
4 Bottom Menu

Say

» To hear a puppet speak one entry, click on Say (or press the Enter Key).
Say-All

» To hear an entire.script, click on Say-All. (To stop a puppet’s performance, press
the Esc Key.)

Erase-All
» To erase the text of a script being written and start over, click on Erase-All.

» If your previous script has not been saved, you are asked if you want to save the
script before starting a new one.

Effects

» To add special effects to the script, click on Effects, then click on:

Open } to open and close curtain
Close

Noise |
Claps
Laugh
Drums | _
Happy |
Sad -
Cancel| _, tocancel the Effects Menu

- to add sound effects

= to enter puppet’s expression into the script

» Click on the effect of your choice. The selected effect will be performed and
automatically inserted into the script.

» To remove an effect from the script, use the Delete Key (just as you would to
remove a letter or word from the script).

11



Program Description
¢Top Menu

File |
Click on File to see the File Menu. Then click on the selection desired.

* New starts a new script.

« Open allows the user to see a list of the prepared
scripts. Click on the desired script (the script is

highlighted). Then click on Open (or press
Return) to load it.

Open 1 - Saveallows the user to save a script onto the
disk. The puppets' costumes, expressions, and
the scenery are saved with the script. Script titles
of two words or more must be separated with a
period. (For example: Moon.Walk) To save a
script on a disk other than thePlayWrite disk, see
Saving Your Work (page 32).

EARRARIENEARARDRRRS

[ save

g

[ Print

[ Delete ]
[ Quit ]
[ Cancel ]

2
e e

RRRRURRRAMRRBAARR

» Printis selected to print the puppets, stage, and -
script together, or to print the puppets and stage
separately from the script.

.
%
.
|
4
;i
12
.

» Delete is selected if an entire script is to be
deleted from the disk. To delete a script saved on
a disk other than PlayWrite, see Saving Your
Work (page 32).

Quit is selected if the user wants to quit the
PlayWrite program. (If the script has not been
saved, you are first asked if you want to save it.)

Cancel removes the File Menu from the screen.

12



Program Description
Setup

A puppet's name, gender speed of speaking, or pntch of voice may be changed
Click on Setup to view the options:

fL File  Eand Words ?

|

|

i

- b . . pepre———, R oA e R _"i
Name: [Bravo ] Name: [Encore ] |
|

__,.,__.,.,.,,_.-.... e s s e i o m

» To change a puppet's name, click in the name box. Use the Delete Key to
remove the name. Type the new name. (Press the Tab Key to move c. ‘zkly
from one name box to the next.)

Note: Names cannot be longer than six letters. Some type of abbreviation can
be used for names longer than six letters. For example: PlayCat can be
shortened to PCat.

» To change the puppet's gender, click on the circle by boy or girl.

» To change the speed with which lines will be spoken, click on the bar in the
speed box and drag it up to set the voice speed faster or drag the bar down to
make it slower.

» To change the pitch of the puppet's voice, click on the bar in the pitch box and
drag the bar up to make the pitch higher (as for a girl) or drag the bar down to
make the voice pitch lower (as for a boy).

» To cancel the changes and leave Setup as it was originally, click on Cancel.

» To save changes in Setup, click on OK.

13



Program Description
Words

PlayWrite puppets pronounce words according to a set of stored rules. For
example, the puppets know how to pronounce common letter combinations like
the ightin “night” or “right,” and they know not to pronounce the “silent e” at the end
of a word. The puppets pronounce most words correctly, but sometimes they make
mistakes. For example, if the word aisle is used in a script, the puppet will
pronounce it phonetically just as it is spelled. There are two ways to solve this
problem. One approach is to change the spelling of aisle in the script to the
phonetic spelling, eye-ul (The hyphen in eye-ultells the computer to pronounce
each syllable separately.) Another approach is to spell aisle correctly in the script
and enter a phonetic spelling of aislein the Words list. To enter a phonetic
spelling, click on Words. Notice the two columns in the Words list. The left column
shows the spelling of a word, and the right column shows how the word should be
pronounced.

guitahr
heeerz
laff
il laughter laffter
dlives lie-vz
octopus octuhpus
il ok ok
woe—-nt

( Add ) ([ Remove )[ Change ) [ Say

» To add a word (for example, aisle) to the Words list, click on Add. Then type aisle
in the first box. Click in the second box (or press the Tab Key to move from box to
box) and type eye-ulas it is spelled phonetically. Click on Done and the word
aisle will be added alphabetically to the Words list. The puppets will then
pronounce aisle correctly when it is used in the script.

+ To remove or change a word from the Words list, first click on the word to highlight
it, then click on Remove or Change. For example, if lives (as in John lives on
Maple Street) is the desired pronunciation, click on lives and then on Remove to
remove the long i (lie-vz) phonetic spelling in lives. You will be asked if you are
sure you want to remove lives from the Words list. Click yes. Then lives with a
short i will be heard in your script.

« If you type in a word already in the Words list, you are first asked if you are sure
you want to replace it. Answer yes or no.

» To save the changes and return to the puppet script, click on Done.

14



Program Description

Suggestions for Creating Phonetic Spellings

Each vowel has several different pronunciations, and sometimes PlayWrite may
use the wrong one. For example, the ain guitarwas pronounced incorrectly, so
the a was changed to ah (guitahr).

Using hyphens can be very useful. PlayWrite will pronounce each part of the
hyphenated word separately. For example, to produce the long o sound in won't, it
is spelled woe-nt. Similarly, to have a long i sound in lives, it is spelled lie-vz.

For words that end in an apostrophe and an s, write the word in the Sounds Like
column in the Words list without the apostrophe for the sto be pronounced.

When the pronunciation of a word is changed, other forms of that word are not
automatically changed. For example, the word laugh is spelled phonetically /aff for
the correct pronunciation. But if students choose to use the word /aughing in their
script, they will need to add the phonetic spelling for /aughing (laffing).

Synthesized speech does have limitations, and some compromises must be made
when using a program with synthesized speech. For example, in regular
conversation the homograph word livesis pronounced two different ways
depending on how the word is used. In PlayWrite, there is no way to recognize
how a word is used; each word must always be pronounced the same way.
Consequently, when homograph words such as lives, wind, or bow are used, a
phonetic spelling may have to be changed according to usage.

15



Let Students Lead the Way

There are many different ways to use PlayWrite. One of the simplest ways, but also one
of the best, is just to let students write about anything they want to write about. Students
should feel free to experiment and try new things. They are likely to learn much more if
they view PlayWrite as a playful activity and if they care about the things they are writing.

Prewriting

Before students sit down at the computer to write scripts, you might want to have a pre-
writing session. During this session, students can develop ideas for their scripts.

What are the characters like?
What is the plot?

Is it happy or sad?

Is there a moral to the story?
Is there a climax?

This is a good time to discuss literary terms like plot and script. For more detailed teaching
suggestions involving story development, see the Story Development section
(page 20). A Character Development Worksheet (page 19) is also included.

There are many ways to organize this session. Students could brainstorm as a whole
class or develop ideas in small groups (or individually), and then share their ideas with
the whole class.

Topics to Write About

Engage students’ imaginations and enthusiasm as they decide what to write about. If
students have trouble deciding what to write about, you can suggest that they change the
puppet costumes or background scenery. New costumes often spark students’
imaginations and trigger new story ideas. The puppet costumes were designed to evoke
a variety of situations.

16



Focus on Writing

You might also suggest that students write scripts about some things that happened to
them recently in school or at home. They could even base puppet characters on people
that they know. (You may want to discuss with students the appropriate use of real people
in their scripts. For example, no intentional derogatory or discriminatory statements should
be included in their scripts.)

Viewing performances of the prepared PlayWrite scripts (Dogtor and Greetings) might
also initiate new ideas.

Very young students might want to write versions of their favorite fairy tales (with two main
characters, of course) or create original fairy tales of their own.

Additionally, you could link PlayWrite activities to topics in the curriculum; you could ask
students to write scripts related to current social studies or science topics that they are
studying.

Note: Puppet Plays (a separate SUNBURST product) is a helpful resource for creating
scripts. The Teacher’s Guide provides complete lesson plans for writing plays
(prewriting to production) including the circus, robots, a mystery, famous people,
endangered species, tall tales, and many more. Students could use these ideas
to write scripts for the two PlayWrite puppets.

Character Development

As students write PlayWrite scripts, they need to develop personalities for the puppets.
This is a good opportunity to discuss the idea of “character development.” Here are some
questions you might use for discussion:

What are the important parts of a person’s personality? Some possible responses:
— a person can be honest or dishonest
— a person can be funny or serious
— a person can be considerate or mean to others

* What makes one person different from another? Discuss how a person’s
appearance is a superficial difference. Other differences are much more important.

» Ask students to describe characters that they know from books or television. Ask
students to identify the character’s most distinguishing features. In other words,
what makes the character special?

» Ask the students to write down “personality descriptions” of their friends—or of
themselves. They should not use any physical descriptions.

17



Focus on Writing

Actors and actresses can act out many different personalities. Sometimes they
change the clothes they wear and how they wear thelr hair. What else do they
change? Some possible responses: .

— they change their facial expressions

— they change the tone of their voices

— they change their accents

— they change the types of things they say:
use jargon and expressions the characters they’re representing would

use, and talk about things that would be of interest to their characters.

In developing personalities for their puppets, it is sometimes useful for students to write
down some information about the puppets. The Character Development Worksheet on
the next page can help students focus on important character information. You can make

copies of this Worksheet and give one to each student.

18



Character Development Worksheet

Name:
Occupation:
Costume:
Address:
Likes:
Dislikes:
Habits:
Hobbies:

Add more information about the puppet below. ..

19 NBLRST
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Focus on Writing

Story Development

In addition to developing personalities for their puppet characters, students need to
develop a story line or plot. Here are some things to discuss:

» Stories often follow one of several standard patterns. One common pattern:
— introduction of the characters
— introduction of the problem
— solution to the problem
— conclusion or ending

+ Read several stories to the class, then discuss the similarities and differences
among the stories.

» There is no “recipe” for a good story, but there are certain common “ingredients.”
For example, good stories usually involve problems that are familiar to the
listener. Even if the story is set on a foreign planet, the characters usually deal with
problems that are familiar to people. It may be helpful to have a brainstorming
session about common problems such as sisters and brothers getting along,
humorous and serious family situations, etc. In addition, many good stories have
an “unusual twist”: something unexpected happens.

» To help students develop stories, give them “starter scripts"—brief story beginnings
that students can finish on their own. (See “starter scripts,” page 23.)

Spelling

As students use PlayWrite, they might spell some words incorrectly. For example, they
might type nite instead of night. It is probably best not to worry about standard spelling
right away. Initially, it is more important for students to experiment with sounds and to
become comfortable with writing. Most students’ spelling improves naturally as they write
and read more.

If you want to focus more attention on spelling, you might print out students’ scripts and
suggest that they correct the spelling on the printouts. That way, students can still
experiment freely while writing the scripts, but can learn about correct spellings
afterwards. Every once in a while, you will find a word that the computer pronounces
incorrectly—even when the word is spelled correctly. You should encourage students
to add such words to the Words list (see Words on page 14).

Sometimes you may have to assist students (especially younger students) with the
process of adding or changing phonetic spellings in the Words list. You may want to
spend a class period (or more) using the Words list with students. Students might
suggest some words that would be good examples to be added to the Words list.

20



Focus on Writing

You can also help students learn some “tricks” for getting correct pronunciations in the
Words list. One “trick” is to use hyphens to separate syllables in words (and spell words
phonetically) to make sure the vowels are pronounced correctly in each syllable. For
example: changing won’tto woe-nt.

Working at the Computer

If there is a computer in the classroom, you can set up PlayWrite as an activity station.
That way, one or two students can work on PlayWrite scripts while other students are
working on other activities. If there are several computers in the classroom (or an entire
computer lab available), the whole class can write PlayWrite scripts at the same time.

It is often a good idea for students to work together in pairs. Each student can take
responsibility for one of the puppets. One student creates the costume and name for one
of the puppets, the other student creates the costume and name for the other puppet.
Then the students alternate writing lines of dialogue for the puppets. Bilingual students,
and students learning English as a second language, may find it helpful and fun to work
with an English-speaking or bilingual student to write scripts together. If desired, students
could also work in small groups (3—4 students), dividing responsibilities.

Sharing Scripts
After several sessions with PlayWrite, each student (or group of students) can make a
presentation about a script to the rest of the class. Students can be encouraged to explain
the process used to write their scripts:

* how they got their ideas for their scripts

* how their ideas (and puppets) changed as they wrote their scripts

* what advantage they felt was gained by working with another student

* how they learned about a topic in a curriculum area (for example, science or
social studies) by writing about it

Theater ldeas

In addition to watching the computer puppets perform, students can produce live
performances:

» Students can make costumes for themselves, then act out their own scripts.

» For a more advanced project, students can make marionettes and control them
with strings.

21



Focus on Writing

» Students can make real puppets and put on a real puppet show. Students can
make simple puppets from Popsicle sticks, or they can make “finger puppets” from
small pieces of fabric. '

Note: PuppetMaker (a separate SUNBURST product) lets students design and print
their own puppets. Students can write a script with PlayWrite and listen to the
PlayWrite puppets perform. Then using PuppetMaker, they can create puppets
for a live performance. PuppetMaker provides dozens of combinations of
puppet possibilities in the following categories: paper bag puppets, string
puppets, finger puppets, walking puppets, and shoe box puppets.

As students prepare for these performances, it is a good opportunity to discuss new
vocabulary words related to plays and theaters. Here are some examples:

 script, character, dialogue

* act, scene, intermission, curtain call, encore
» stage, scenery, costume, prop, special effect
» dress rehearsal, opening night

* comedy, drama

Exploring Feelings

This is a special-purpose activity. You can use PlayWrite to explore what a student is
thinking and feeling. Puppets offer a non-threatening way for students to express their
inner feelings. Students are often reluctant to articulate certain emotions, but they might
speak their feelings through the puppets. For example, if a student is angry at another
student in the class, you might set up the puppets to represent the two students, then let
the angry student write a script for the two puppets. The two students could then listen to
the script and discuss their feelings about it. After their feelings are discussed, the
students may want to write a new script together.
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Starter Scripts

Starter scripts (brief story beginnings that students finish on their own) are particularly
useful when students are having trouble coming up with their own script ideas. Before
students work independently, you may want to work together as a class to finish one of the
starter scripts. ‘

It is interesting for several students to work from the same starter script. After they finish
their stories, discuss how stories can be very different, even when they start with the same
beginning.

After students have some successful experiences working with new starter scripts,
encourage them to create their own starter scripts for their classmates.

Copies of the three starter scripts saved on the PlayWrite disk follow:

Starter.1

File Setup Words |

Rover <Open>

- Hi. I'm Rover the Reporter. We are here on the planet Playto to
interview PlayCat.
Could you please tell us why your planet is called Playto?

PCat It is called Playto because everyone here plays all the time. It is illegal
to work on Playto.

Rover Fascinating.
What do you do on Playto?

PCat | am the Play Police.
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- Starter.2

File Setup Words

o

Doctor <Open>
Are you next?
Jenny
- Starter.3
Homer <Open>
Greetings. Where are you from?
Etaoin I am from the planet Shrdiu. Why are you wearing those
strange clothes?
f\ Homer
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Dogtor

Queen

Dogtor
Queen
Dogtor
Queen

Dogtor

Queen
Dogtor
Queen
Dogtor

Queen

Dogtor

Queen

Dogtor

<Open>

<Sad>
Thank you for coming to the Palace, Dogtor.

What seems to be the problem, your Majesty?

| have a royal pain in the neck.

I'm not surprised. Heavy hangs the head that wears the crown.
You're right. This crown weighs 50 pounds.

Well, laughter is the best medicine. When was the last time that you
laughed?

Eight lives ago.

OK. Here's a joke. What does a kitten put on a hot dog?

| don’t know. What?

Cat-sup.

<Happy>

<Drums>

<Laugh>

Look! You are cured!

Thank you so much, Dogtor. It's so difficult to find a dogtor who makes
castle calls these days.

<Claps>
<Close>
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Greetings

Bravo <Open>
- <Claps>

I'm Bravo the Dog.
Encore I'm Encore the Cat.
Bravo We're glad you came to have a chat.
Encore We're friendly pets and like to play.
Bravo Whatever words you type we’'ll say.
Encore It's easy to make a puppet show.
Bravo Just write about the things you know.
Encore We can play most any role.
Bravo You're the playwright, in control.
Encore You can pick and choose our clothes.
Bravo And dress us up from head to toes.
Encore You can change our faces too.
Bravo Make us happy, or make us blue.

<Sad>
Encore Work by yourself or with a friend.
Bravo <Happy>

Write a real story or play pretend.
Encore The stage is set for Opening Night.
Bravo So sit right down and start to write!

<Drums>

<Claps>

<Close>
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Demonstrating
PlayWrite
to Students

Lesson 1: Writing a New Script

Throughout this lesson, someone needs to be working at the computer. Do this yourself or
choose a student to do it.

Starting the software

» Put the PlayWrite disk into the Apple IIGS 3.5 disk drive and turn on the computer
and monitor.

Describing PlayWrite
* As PlayWrite is loading, tell students that PlayWrite will let them become
playwrights, writing scripts for two puppets to perform. (You may want to
write playwright, PlayWrite, and script on the board, and discuss what
they mean.)
Changing costumes, expressions, and scenery
» Show the puppets’ different costumes, their expressions, and the scenery.
» Discuss an idea for a script.

» Choose costumes, expressions, and scenery that are appropriate for the idea.

» Depending on the idea for the script, you may want to click on Setup (page 13)
to show how to change puppet names and voices.
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Writing dialogue
Involve the _class in writing a short (3—4 lines) dialogue:
» Let the class suggest what each puppet will say.
» Type in each line.
» After each line is typed, click on Say (or press Enter).
* When the entire script is written, click on Say-All.

» If a word is not pronounced correctly, demonstrate how to change the spelling
phonetically in the script, or add the word to the Words list (page 14).

Note: Two approaches may be considered at this point in the demonstration:
Allow students to begin writing scripts of their own now, introducing other
PlayWrite features as the need for them arises, or continue demonstrating
PlayWrite features and then have students begin writing scripts on
their own.

Adding special effects

Demonstrate Effects to students:

Open
Close
Hoise
Claps
Laugh
Drums
Happy
Sad
Cancel

» Let the class suggest adding one or two effects to the script.
» Add the effect(s) to the script.

» Demonstrate deleting an effect from a script.
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Demonstrating PlayWrite to Students
Editing a script
Demonstrate these basic editing features:
* Move the cursor through the lines of a script with the Arrow Keys.
» Use the Scroll Barto move through a script. -
» Demonstrate more detailed editing features (Editing Features, page 10) now
or later when students are writing scripts on their own.
Saving a script
Demonstrate saving a script.
» Type in the name for the class script. Then click on Save.
* Remind students that the puppets’ costumes and scenery are saved with
the script.
Quitting a script
Demonstrate quitting a script.
» Remind students that to quit PlayWrite they should not simply turn off the
computer. Rather, they should first select Quit from the File Menu.
This approach has two advantages:
— PlayWrite will remind students to save any unsaved work.
— Students won't risk interrupting an operation in progress (as they might if

they simply turned off the computer).

« Demonstrate pushing the disk drive eject button and carefully removing the disk.
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Demonstrating PlayWrite to Students

Lesson 2: Loading and Listening to a Script
Demonstrate loading a script with the class:
» Load and listen to the class script (previously saved).

» Load and listen to Dogtor.

[ File Setup Words

‘&‘OIi‘O.

Thank you for coming
Say-All Say Erase-A11 Effects

\_ /

Note: You may want to briefly discuss the plot, characters, mood, and setting in
Dogtor to identify these parts of a story with the class now, or you may
want to discuss them later as part of a prewriting discussion.

* Load and listen to Greetings.

7
| File Setup Words D

I'm Bravo the Dog.

Say-A11 Say Erase-A11 Effects
\_ W,
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Saving Your Work

Saving on the Apple lIGS

When you select Save from the File Menu, PlayWrite will display a standard “Save”
dialogue box which.should be familiar to most Apple 1IGS users. For those who are new to
the IIGS, an explanation of the Save Dialogue may be helpful.

» First of all, each script is saved as a “file” on the disk. To save your work, the Save
Dialogue needs to know two things: what you want to call your script and where
you want to save it.

» To give your script a name, simply type the name in the Save Dialogue. The name
should appear in the rectangle at the bottom of the dialogue.

* You can save your work directly on the PlayWrite disk, or onto a different disk. Your
script is saved and will be listed with the other scripts.

Saving on the PlayWrite disk

After you type the name of the script, just click on the Save button. That's it.

- Saving on another disk

You can save your script on any ProDOS formatted disk. Place your formatted disk in a disk
drive. Click the Disk button (in the Save Dialogue) until the name of the disk appears.
(The name might appear as soon as you insert the disk.) After you type the name of the
script, click Save to save your file.

A note about folders

On each disk, scripts can be organized into “folders” (also known as subdirectories). On
the PlayWrite disk, scripts are automatically saved into a folder called Scripts. You can
save files in a different folder if you'd like. To create a new folder, enter a name in the
Save Dialogue (as if you were going to name a script), but then click New Fold<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>